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Profiling Guide

The TouchXpress family of capacitive sensing fixed function devi-
ces provide robust, responsive, and low-power solutions for ap-
plications that need to add a touch sensing interface.
Common applications for these devices include remote controls, white goods designs,
and wall-mounted touch panels such as thermostats and smart light switches. Simplici-
ty Studio tools provide streamlined and powerful configuration and testing of TouchX-
press devices in every stage of product development.

This document discusses how to develop capacitive sensing interfaces using the 
TouchXpress family and Simplicity Studios tools. Simplicity Studio can be downloaded 
from the Silicon Labs website: www.silabs.com/simplicity.

KEY POINTS

• Use Xpress Configurator in Simplicity
Studio to configure the TouchXpress
device.

• Use Capacitive Sense Profiler in Simplicity
Studio to analyze the capacitive sensing
system and test for system robustness.
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1.  Workflow Overview

Many capacitive sensing-enabled products follow a similar development flow:

• Evaluation — This stage usually involves using vendor-provided evaluation boards.
• Fly-wire prototyping — In this stage, the developer may route wires from a vendor evaluation kit to copper tape in a product mock-up

case to simulate the touch interface.
• In-system prototyping — This stage involves low volume PCB manufacturing with capacitive sense devices on-board, routed to

PCB-implemented touch sensors.
• Deployment — In this stage, the final configuration of the capacitive sensing device is installed in the final revision of the product

hardware.

The tools provided by Simplicity Studio enable this entire development flow for the TouchXpress devices.
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2.  Simplicity Studio Tools

The TouchXpress devices, combined with tools provided in Simplicity Studio, support each step of this development process with both
configuration and real-time capacitive sensing data visualization. Touch sensing development usually falls into an iterative workflow,
where a configuration is defined, tested, refined, and tested further. The test loop completes when a configuration achieves the respon-
siveness and current draw requirements of the design.

2.1  Xpress Configurator

Simplicity Studio supports device configuration through [Xpress Configurator]. For TouchXpress devices, the user can configure all
aspects of functionality, including:

• Sensor enable or disable
• Sensor scanning parameters such as threshold, accumulation, and gain settings
• Active mode and sleep mode scan period
• Configuration of on-chip components, such as the buzzer output and slider

The tool validates all changes to a configuration and alerts the user to any problems or potential issues with a configuration in a [Prob-
lems] list toward the bottom of the view. Once the user has developed a configuration that is valid, the user can download the configu-
ration to a device by clicking [Program to Device].

Figure 2.1.  Xpress Configurator
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The tool also includes datasheet-derived information about each configurable parameter. This information can be accessed by clicking
on the small [I] buttons next to each parameter. The datasheet text will then appear in the documentation pane toward the bottom of the
screen.

Figure 2.2.  Xpress Configurator Parameter Documentation
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2.2  Capacitive Sense Profiler

Developers can examine real-time, in-system TouchXpress device output through [Capacitive Sense Profiler]. Once connected to a
device, [Capacitive Sense Profiler] periodically reads run-time data from the TouchXpress device and displays it on-screen. Each sen-
sor of the device can be included or excluded from the graphical display through the [Selected Channels:] controls, and data types
such as raw data, baselines, thresholds, and touch deltas can be selectively displayed on-screen.

Figure 2.3.  Capacitive Sense Profiler

2.3  Demos and Example Projects

Connecting a TouchXpress device to Simplicity Studio will reveal a [Demos] tile that includes example configurations for the device.
Using this tool, a user can download the template configuration profile to a device and run [Capacitive Sense Profiler] to examine the
system performance.

Additionally, a user can create a project in [Xpress Configurator] and click [Import From Device] to read the configuration profile from
the device and populate the project parameters with the profile contents.
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2.4  Other Programming Options

Xpress Configurator produces an Intel hex image that contains the configuration profile. This hex image can be accessed by expanding
the configurator project in the Project Explorer, which can be accessed by clicking [Window]>[Show View]>[Project Explorer].

Once the project being configured is expanded, a file list appears that includes a .document file and a .hex image. Right-clicking on
the hex image and selecting [Browse Files Here] will take the user to the directory containing that hex image. This image can be pro-
grammed into TouchXpress devices using Simplicity Studio's [Flash Programming] utility, or through a command-line utility using the
Silicon Labs programming DLL.

To order pre-programmed devices from Silicon Labs, click the [Request Parts] button in [Xpress Configurator] and fill out the required
information. Then, click [Confirm and Send].

2.5  TouchXpress Program and Communication Interface

TouchXpress devices provide a two-wire interface that is used for both configuration profile programming and real-time data reads.
Connecting a ToolStick Debug Adapter to the Config Data and Config Clk pins on a TouchXpress device creates a link between the
device and Simplicity Studio. A ToolStick Debug Adapter is included on the TouchXpress evaluation boards to fascilitate configuration
and programming with the evaluation system. Stand-alone ToolStick Debug Adapters are also available to test devices in-system
(www.silabs.com/toolstick).

2.6  Example Xpress Configurator and Capacitive Sense Profiler Usage

The short example in this section illustrates how [Xpress Configurator] and [Capacitive Sense Profiler] can be used together to con-
figure and tweak the settings of a TouchXpress device. In this demonstration, a device using a 1/8th inch acrylic overlay will be tuned
for optimal performance.
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2.6.1  Step 1 — Connecting to the Device

Configuration of a device begins in [Xpress Configurator]. Connecting the board to Simplicity Studio causes a set of compatible apps
to appear in the launcher window.

Figure 2.4.  Simplicity Studio with a TouchXpress Device Connected
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2.6.2  Step 2 — Creating an Xpress Configurator Project

Click on [Xpress Configurator] in Simplicity Studio to open the configuration tool.

Figure 2.5.  Launching Xpress Configurator

If this is the first time [Xpress Configurator] runs, a new project creation dialog box will appear. Otherwise, the last-opened project will
automatically open. In this case, create a new project by clicking [File]>[New]>[Xpress Configurator Project].

Figure 2.6.  Creating a New Xpress Configurator Project

The dialog box that appears will allow the user to select the TouchXpress device and name the new project.
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2.6.3  Step 3 — First Configuration

A new project will show two problems in the [Problems] list.

Figure 2.7.  Problems Shown in a New Xpress Configurator Project

These problems will disappear when at least one sensor has been enabled and at least one enabled sensor has been designated as a
wake-up source.

For this example, enable all the sensors using the [Fill Down] button. The [Fill Down] button copies configurable parameters from
CS00 and fills that information into all sensors that follow.

Check the [En] box for the CS00 channel. After clicking [Fill Down], the sensor configuration should look as follows.
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Figure 2.8.  Initial Configuration Complete

2.6.4  Step 4 — Programming the Device

Because no problems appear in the [Problems] list, the device can now be programmed. This can be accomplished by clicking [Pro-
gram To Device].

Figure 2.9.  Programming the Device
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2.6.5  Step 5 — Starting in Xpress Configurator

Switch to the [Capacitive Sense Profiler] by clicking the profiler button in the top-right of the Simplicity window or by returning to the
main launcher window and clicking the [Capacitive Sense Profiler] tile.

Figure 2.10.  Profiler Button
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Once switched to the profiler, read real-time data from the device by clicking on the [Play] button.

Figure 2.11.  Starting to Collect Capacitive Sense Data
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In order to more closely examine sensor performance, set the tool to display only one sensor by checking only one box in the [Selected
Channels] window. Alternatively, just type the channel number into the text box.

Ensure that data fills the entire viewing space by enabling the y-axis adjustment feature button along the top of the graphical view.

Figure 2.12.  Enabling Y-Axis Adjustment

Finally, add or remove data types from the graphical display using the [Selected Data Types:] list. In this case, Thresholds, Raw data,
Baseline, and Expected Range are displayed. Note that the expected range is over twice the delta of what is reached by touching a
sensor. This is due to the fact that the board under test is using a 1/8th inch overlay, and the default touch deltas are configured to
expect a 1/16th inch overlay. Upon examination, it looks as though the touch deltas seen during a touch are closer to 300 codes.
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2.6.6  Step 6 — Adjusting Touch Deltas in Xpress Configurator

Return to Xpress Configurator by clicking the configurator button in the upper right part of the screen.

Set touch deltas to 300 codes by typing [300] into CS00’s [Touch delta] text box and clicking [Fill Down].

Figure 2.13.  Adjusting the Touch Deltas

Programming the device by clicking [Program To Device] will cause touch qualification to use the new touch deltas.
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2.6.7  Step 7 — Checking Changes in Capacitive Sense Profiler

After clicking the [Play] button again, the data displayed shows that the touch delta is now properly scaled for the 1/8th inch overlay,
and touches are now being qualified successfully.

Figure 2.14.  Checking the Adjusted Touch Deltas
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3.  Configuration Tips

While TouchXpress devices are designed to provide responsive, reliable performance at optimally low current draw for all valid configu-
rations, most TouchXpress-configurable parameters do require some degree of trade-off between robustness and current draw. In gen-
eral, more scanning and sensing time means more time in Active or Optimized Active states of operation, which results in a higher
average current draw than a system that can remain in Sleep mode for a higher percentage of operating time.

The table below provides recommendations on configurable parameters that present a current draw vs. robustness trade-off. Note that
the term robustness in this context refers both to responsiveness and to robustness against coupled interference events.

Table 3.1.  Recommendations for Optimal Current vs. Optimal Robustness

Parameter Optimal Current Notes Optimal Robustness Notes

[Active mode scan type] Choose [one scan per period].

This setting will allow the device to drop in-
to a Sleep state after being in Active/Opti-
mized Active during a scan of enabled sen-
sors.

Choose [free run mode].

This setting prevents the device from ever
going into Sleep mode, instead executing
successive enabled input scans as quickly
as possible. Higher scan frequency means
faster touch qualification and a more re-
sponsive system.

[Active mode scan period] When coupled with Active mode scan type
set to [one scan per period], a higher ac-
tive mode scan period means that the sys-
tem will stay in a low power Sleep state for
a higher percentage of operating time, low-
ering average current draw.

Lower Active mode scan periods result in
faster touch qualification.

[Counts before sleep] Lower [counts before sleep] results in a
system that enters Sleep mode more quick-
ly to reduce current consumption.

A higher [counts before sleep] value re-
sults in a system that stays in Active mode
scanning for longer, ensuring optimal re-
sponsiveness during user interaction.

[Accumulation] Lower accumulation means less time spent
in Active and Optimized Active power
states.

If Active mode scan type is set to [one
scan per period], the device can spend a
higher percentage of time in a Sleep state
between scans.

Higher accumulation increased digital filter-
ing, which increases signal-to-noise ratio
(SNR).

3.1  Debounce vs. Active Mode Scan Period Considerations

The debounce parameter in [Xpress Configurator] is the setting that controls the number of contiguous sensor scans that must fall
above or below thresholds in order for the sensor to be qualified as active or inactive, respectively. The higher the debounce number,
the more scans must result in threshold crossings contiguously before an event is qualified. While this parameter improves robustness
against spurious interference events, increasing this value also has an effect on responsiveness.

A system optimized for responsiveness and robustness can have a combination of high debounce value and either a fast active mode
scan period or a device’s active mode scan type set to [free run mode]. In a system where scans occur more frequently, the terminal
debounce value can be reached faster, preserving response time.

A device’s responsiveness is primarily a function of the debounce setting and the active scan mode period. A good rule of thumb is to
make sure that the debounce setting times the active mode scan period is less than 100 ms, if active mode scan type is set to [one
scan per period].
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3.2  Touch Delta and Threshold Configuration

A sensor’s touch delta is the sensor’s output value relative to a baseline when the sensor is active or touched by a user. The touch
delta seen by a sensor is a function of the following factors:

• the size of the sensor
• the thickness of the overlay
• whether the sensor is surrounded by ground pour
• the drive strength setting of the sensor

For PCB layout recommendations, see Application Note AN447: Printed Circuit Design Notes for Capacitive Sensing with the CS0 Mod-
ule. Application notes can be found on the Silicon Labs website (www.silabs.com/interface-appnotes) or in Simplicity Studio using the
[Application Notes] tile.

The optimal sensor size tends to be around the diameter of the surface area created by a finger pressed against a surface, which is
7-10 mm. The most commonly used overlay is an overlay of 1/16th inch in thickness. The drive strength setting for most sensors using
these common hardware specifications is 8x gain. All of these factors result in a touch delta of around 700 codes, which is the default
touch delta setting in [Xpress Configurator].

Care should be taken when defining the touch deltas for sensors because a touch delta setting that does not reflect the delta seen by a
sensor in a design can result in a device that reverts to a more conservative touch qualification process, which will limit responsiveness.
It is good practice to check settings in [Capacitive Sense Profiler] to make sure that the configured touch delta for a sensor matches
the real world output of the TouchXpress device.

Thresholds should be set with at least 10% difference between active and inactive thresholds to ensure sufficient hysteresis between
qualification states. Setting thresholds too tightly relative to each other can result in a touch being rapidly qualified and disqualified if the
output codes drift above and below the threshold grouping. The default thresholds in [Xpress Configurator] provide sufficient guard
against this type of behavior.
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3.3  Moisture Immunity Optimization

Slight configuration tweaks can ensure a configuration profile that is optimally immune against water droplets or standing water on a
sensor. Setting active thresholds as high as 80% and active thresholds at 60% or 70% the maximum touched value will help to guard
against the small touch deltas that can accumulate on a sensor due to water droplets. The baselining system in the chip will eventually
rise to swallow those small deltas, but higher thresholds guard against temporary false positive touch events.

The system can be optimized further by enabling touch time-outs. Touch time-outs will cause the baselining algorithm to update more
aggressively, adjusting to compensate for positive delta effects caused by water droplets.

Figure 3.1.  Guarding a Capacitive Sense System Against Moisture
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4.  Example Development Workflow

Because of the iterative nature of development, the tools in Simplicity Studio have been designed to work together to enable users to
easily switch between [Xpress Configurator] and [Capacitive Sense Profiler] with minimal effort. The example below shows how the
these tools work together with hardware, first using the TouchXpress evaluation board and on-board sensors, then the evaluation board
and flying wires to a copper tape mock-up, and finally to a prototype final design with on-board hardware and sensors.

4.1  Step 1 — Starting in Xpress Configurator

Use the [Demo] tile in Simplicity Studio to load a TouchXpress evaluation board with a standard configuration profile. After this step, a
user can create a new [Xpress Configurator] project and import the image. This gives a good start on the feature settings. Other fea-
tures such as the buzzer and touch time-outs can be configured here to find a feature set that seems promising for the product being
developed.

Figure 4.1.  Downloading a Configuration Profile Template
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Figure 4.2.  Importing the Device Image in Xpress Configurator
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4.2  Step 2 — First View in Capacitive Sense Profiler

The user can analyze the performance using the chosen configuration by clicking on the button on the upper right of the Simplicity Stu-
dio window. Once in [Capacitive Sense Profiler], the user can click on the [play] button to view the TouchXpress real-time data output.
If the user presses and releases a button, the tool will calculate SNR and other statistics for that touch.

Figure 4.3.  Using Capacitive Sense Profiler
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4.3  Step 3 — Measuring Current

The TouchXpress evaluation boards offer an in-series via pair that can be tapped into with a current meter to evaluate average current
draw. Removing the zero ohm resistor near the via pair will open the circuit, enabling the current meter to measure all current that the
device is using.

Figure 4.4.  Measuring Current Draw on a TouchXpress Evaluation Board

Note that, while the [Capacitive Sense Profiler] is minimally intrusive, it will lower active mode scan time due to the periodic reads of
run-time data. During these reads, the device will be in a relatively high ( > 3 mA) current draw state, and a single read can take as long
as 50-100 ms. For this reason, current evaluation should be made when the TouchXpress device is not connected to [Capacitive
Sense Profiler] and streaming data on-screen.

The recommendations for improving current draw in this document should be used as a guide to tweak scan times and settings to ach-
ieve the desired average current draw.
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4.4  Step 4 — Fly-Wire Proof of Concept

In many cases, the next stage of development involves using a product mock-up, possibly with a host processor running other system
components that will all be integrated onto a single PCB in later development stages. At this stage, it is likely that the on-board sensing
electrodes on the TouchXpress evaluation board will be replaced by copper tape stuck to product mock-up overlays or a case.

The evaluation board can continue to be used in this stage of development to analyze the prototype system. Each sensor input pin is
accessible through a row of vias found on the evaluation board. Each via has a corresponding zero ohm resistor that shorts the device
input pin to the corresponding sensing electrode. Removing that zero ohm resistor disconnects the sensor input pin from the sensing
electrode. The user can then solder a wire into the sensor input’s via, fly that wire to a copper tape-implemented sensor, and solder the
other end of the wire to the copper tape.

Figure 4.5.  Connecting External Sensing Electrodes on a TouchXpress Evaluation Board

If the mock-up uses a host MCU, that MCU may want access to the TouchXpress device’s output pins. For the CPT007B, the host
MCU would need access to the OUT pins corresponding to each input sensor. For the CPT112S, the host MCU would need access to
the device’s I2C pins and the device’s interrupt pin. All of these signals are available through the evaluation board's side-edge expan-
sion (EXP) header. A schematic included with the board’s user guide provides a pinout for this connector.

4.5  Step 5 — Checking Mock-Up Performance

The [Capacitive Sense Profiler] tool can be used at this point to check whether touch deltas with the copper tape have changed dra-
matically relative to the touch deltas seen on the TouchXpress evaluation board. If touches cause a touch delta that is greater than 10%
of the previously-configured touch delta, switch back to [Xpress Configurator] and adjust the deltas accordingly.

The interface requirements between the TouchXpress device and the host MCU may require additional configuration changes. For the
CPT007B, the OUT pin drive strength can be switched to open-drain output if the interfacing MCU requires 5 V logic with pull-ups. The
polarity of the OUT pins can also be switched between active high and active low, depending on host MCU requirements. For the
CPT112S, the I2C address may need to be changed from its default value of 0xE0, if the device will be connected to a bus with another
device that has a conflicting address.

4.6  Step 6 — Interfacing with Prototype Boards

When the development reaches a point where prototype boards are being created, perform in-system configuration and data analysis
through Simplicity Studio by routing the TouchXpress device Config Data and Config Clk pins to vias on the prototype board.

A separate ToolStick Debug Adapter board can also be wired into those vias to maintain a link with [Xpress Configurator] and [Capac-
itive Sense Profiler]. The programming guide AN949: TouchXpress™ Programming Guide can be used for reference on how to con-
nect a ToolStick Debug Adapter to a prototype board.
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4.7  Step 7 — More Analysis in Simplicity Studio

When validating prototype boards, [Capacitive Sense Profiler] can be used to check that touch deltas match expected values. If ad-
justments need to be made to touch deltas, other refinements to the configuration for current draw, or other requirements need to be
made, [Xpress Configurator] can be used to re-configure the device in-system.

In many cases, a prototype stage will require that multiple boards be developed and programmed. The programming guide AN949:
TouchXpress™ Programming Guide can be used for reference on how to program devices in these cases. Once prototyping is com-
plete, use [Xpress Configurator] to start an order for a production run of pre-programmed devices.
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